


RigsEye Service Summary

RigsEye is a data collection, transmission and
display system specifically designed for the oil &
gas well equipment (Rigs, Pumps and Swivels)
with the following features:

» Durable fixed inputs with minimal setup and maintenance

» Utilize low cost cellular data transmission where available but
has option for satellite transfer

» Built-in Data Storage allows for later retrieval if connection to
internet is lost

» Easy to install, setup and stow when moving the equipment

» Minimizes manual inputs
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Web Service Features

>

» Allows creating Projects that groups a rig, pump(s) and swivel

» Minimizes manual inputs from the operator to gather the

Detailed Dashboards for Rigs, Pumps and Swivels displaying
key measurements in line graph and gauge graphics

Detail Dashboard of Engine Data (if connected to the ECM)

together to display key measurements in one screen.

Provides SMS or email alerts when set conditions are met such
as “Blocks moving Posi-Stop Not Set”

Easy to install, setup and stow for equipment moves

information

Provides local WIFI access to wirelessly retrieve files if in an
area with no internet connection to later upload to the server
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Home Page - List View

HOME EQUIP DET/ ENGINE DETAIL ACTIVIT C ER

Below is a list of available equipment to view. Click on the iate tab for the il ion required.

List View | Map View | Multi-Equipment View

Change View To!

REGION ONE REGT

GREENVILLE
Status Last Calibration Info Weather
EquipmentID | Connection Type Carrier Posi-Stop Activity Camera Date/Time Count  Wind Speed Temp Latest Message Today
DA0001 EXCELENT (39) R Stationary | On & Calibrated Yes W Offline | 11/13/2020 14:15:23 2095 N/A N/A No messages today
DA0002 OFFLINE (0) R N/A N/A No 01/13/2021 08:03:16 1989 N/A N/A -
02/16/2021 13:55:28
DA0003 OFFLINE (45) R N/A N/A No 11/11/2020 04:19:33 240 N/A N/A -
11/22/2020 10:30:07
DAP001 VERY GOOD (45) P Stationary  N/A No N/A - N/A N/A No messages today
DAP002 OFFLINE (0) 7] N/A N/A No - - N/A N/A -
01/13/2021 07:57:38
DAS001 EXCELENT (39) 'S Stationary | N/A No N/A - N/A N/A No messages today




Home Page — Map View

Map
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Home Page

» List View of all equipment (rigs, pumps and swivels) the user
has permission to view

» Provides quick status of the cellular connection, equipment
engine, Posi-Stop calibration (for rigs only), weather and if
the equipment is active (pump shaft is rotating, swivel is
rotating and block is moving)

» When user clicks on the equipment Id the detail page for
that equipment is opened.

» When Map View is selected the view display on a Map all the
equipment, each type with a different icon, and color coded
based upon its status.
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Rig Standard Dashboard

- HOME I EQUIP DETAIL I ENGINE DETAIL ]

10 Demo 3 0 No Data
No Data

Greenville mo Demo 0 mph
No Data

POSI STOP DISPLAY RIG LOCATION - TRAVEL TO SITE TODAY'S RIG EVENTS BPRINT TODAY'S MESSAGES BSPRINT
= No message received toda
m BLOCK LIMIT CONTROL. 08:22:25am Low Voltage. (0.0v) g ¥
SYSTEM
BLOCK
POSITION PERCENT OF TRAVEL
WEIGHT ON HOOK DRAW WORKS ACTIVITY TABLE | VIEW CAMERA
Category UOM|14:00 13:00 12:00  11:00 10:00 09:00 | 08:00 07:00 06:00 05:00
Cycles ea| 38 40 | 65 66 | 44 67 65 69 68 63
Cycles/Min ea/min| 0.63 | 0.66 | 1.07 | 1.09 | 073 111  1.07 | 114 113 | 104
Block Travel ft 6,700 6,915 11,229 11,335 8,062 11,285 11,631 11,801 11,649 11,178
Avg Block Speed fUmin| 112 | 115 | 187 | 189 | 134 | 188 | 194 | 197 | 194 | 186
WARNING  LIMIT on Max Block Speed fumin| 105 | 125 | 125 | 100 | 120 | 120 | 125 | 120 | 100 | 110
OFF 3L Avg RPM RPM 100 100 | 100 | 100 | 100 100 | 100 | 100 = 100 100
Max RPM RPM| 105 | 125 125 100 120 120 125 | 120 | 100 @ 110
Avg Weight Ibsx1000 110 0 | 160 | 160 160 | 151 | 151 152 151 151
Max Weight bsx1000 0 | 0 | 162 162 | 162 163 164 | 163 164 | 163
o000 . :
1 2 3 4
1-SLIPS
2-INTERLOCK
3-ROD MANUAL HANDLER
4-ROD LOCKOUT HANDLER
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Rig Dashboard with Camera

- HOME I EQUIP DETAIL I ENGINE DETAIL T ACTIVITY T ‘CAMERA FEED

TESTO1 1312 2 : No Data
Data

N/IC C mo Demo y mpk :51:59 PM ED lent (39)
No Data

POSI STOP DISPLAY RIG LOCATION - TRAVEL TO SITE TODAY'S RIG EVENTS SPRINT TODAY'S MESSAGES SPRINT

12:07:05am Posi-Stop On S No message received today

POSITION PERCENT OF TRAVEL

WEIGHT ON HOOK | BACK TO TABLE




Rig Dashboard

>
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v

Provides GPS Information

Weather Information

Block Position and Speed

Weight on Hook, Bit or Total

Map View that also can provide directions to the rig

Activity Table that can cycle between 15 minute and 1 hour
Increments

Message Board System allows users to text to the server to
display their message in the dashboard (and saved to create a
digital diary)

E}c/ents such as Posi-Stop Calibrated, Turned Off, RPM > 700,
etc...

When Equipped with Camera(s) activity table can be released
with Camera Feed

When Equipped with Interlock or Rod Transfer Safety System
Indicators will illuminate when in use (see slides ??)
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Rig Activity View

= , : : : LR
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‘‘‘‘‘‘‘ o 2o 2 G | st |

BLO oM (N %)
Poston: 100% (Zasmin] (22 Far Gt Dats Seoion | LocalTime: 30747 60

o Rem
Draw Works RPN 0 (2] (22 Fau Ghart | Dats Seocion | LocalTime: 30747 60

(Zoom ) 24 o Gt ][ Dot Saecion ] Loca Time: 30147 P11

Since Rigs Provide so man
data inputs are available a
additional page is availabl
to view these inputs in line
graph format:

» Weight (On hook, on Bit
and total)

» Block Position & RPM

» Well Fluid Data (Pressure
and Flow Rate)




Rig Camera View




Rig Camera View

» When the Rig is Equipped with Camera System up to
4 cameras can be displayed in this view

» Camera System works independent of the RigsEye
data transfer system and can be a standalone
service.

» Has Infrared capabilities

» Cameras have built-in motion sensors and can
provide SMS or email alerts when motion is detected
during off work hours.

» Local NVR hardware stores recorded video for
around 1 week for later review.
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Pump Dashboard

HOME EQUIP DETAIL ENGINE DETAIL CAMERA FEED

Pump Suction: 44.1 PSI Zoom In | 24 Hour Chart || Date Selection | Local Time: 3:05:02 PM

EQUIPMENT LOCATION - TRAVEL TO SITE

MESSAGE BOARD

300

Suction PSIG
23\ ARy
RN
g &

~
o

Pump: Flow Rate GPM: 0.00 GPM Pressure: 918 PSI Zoom In “ 24 Hour Chart || Date Selection | |ocal Time: 3:05:03 PM

No message Available

15000 3a0 Latitude: 34°52"
Longitude: 82°25'15"W
11250 2625
S 7500 2 175
- . ACTIVITY TABLE [ Setto 15 minutes |
3750 875
Category UOM | 14:00 13:00 12:00 11:00 10:00 09:00 08:00 07:00 06:00 05:00 04:00 03:00 02:00 01:00 00:00
0 0 Total Strokes 00 | 00 | 00 | 00| 00| 00 00 00|00 00| 00 00 00| 00 00
Ave Pump Discharge GPM | 000 000 000 000 000 000 000 000 000 000 000 000 000 000 000
Max Pump Discharge GPM | 0.00 0.00 000 0.00 0.00 0.00 0.00 0.00 0.00 000 000 000 000 000 000
R -1 Zoom In ][ 24 Hour Chart ][ Date Selection | Local Time: 3:05:03PM | | Ave Pump Discharge PSI 9217 9216 9215 920.1 9189 919.8 9219 9245 9258 9257 9255 9249 9243 9238 9235
200 Max Pump Discharge PSI|927.0 930.0 927.0 930.0 927.0 927.0 930.0 930.0 930.0 930.0 930.0 939.0 930.0 930.0 930.0
i Ave Suction PSIG | 440 | 441 | 442 | 441 440 | 440 | 442 | 443 443 443 | 443 443 43 442 442
Max Suction PSIG | 444 450 | 450 450 450 450 450 453 453 450 453 453 453 453 450

Temperature
P
o & 8 &




Pump Dashboard

» Provides the following inputs:
» Flow Rate (measured from strokes)
» Fluid Discharge Pressure
» Pump Suction Pressure
» Fluid Temperature
» Message Board
» Map View
» Activity Summary Table
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Swivel Dashboard

HOME EQUIP DETAIL

ENGINE DETAIL CAMERA FEED

RPM: 50 RPM Zoom In |[ 24 Hour Chart | Date Selection | Local Time: 3:04:16 PM | EQUIPMENT LOCATION MESSAGE BOARD

175 No message Available
150
120
Z @
&
60
30
0
Torque: 3233 ft-lbs Zoom In |[ 24 Hour Chart | Date Selection | L ocal Time: 3:04:17 PM
L Latitude: 34°52'17"N
VISIT SITE Longitude: 82°25'14"W
2 5625
< 3150
Z ACTIVITY TABLE [ Setto 15 minutes |
S 1875
B Category UOM | 14:00 13:00 12:00 11:00 10:00
Avg RPM RPM| 50 | 50 | 50 | 51 | 50
Max RPM RPM| 51 | 51 | 50 | 51 | 51
Pressure: 2155 PS| Zoom In |[ 24 Hour Chart | Date Selection | L ocal Time: 3:04:17 PM
i Torque Avg FTALBS| 324 | 325 326 | 325 325
Torque Max FTLBS | 334 | 334 335 | 334 334
3750
Pressure Avg PSI| 2159 | 2167 | 2172 2170 2164
o 2500
Pressure Max PSI| 2225 | 2225 2230 2225 2225
1250
<
0




Swivel Dashboard

» Provides the following inputs:
» RPM
» Torque
» Hydraulic Pressure

» Message Board
» Map View
» Activity Summary Table

@ RigsEye




Project View

Customer: Demo Customer Project: DEV0000001
Pad: testing Start Date: 2021-03-22

Well ID: Not provided

[ Project Site | [ View in Fullscreen | [ 24 Hour Chart | [mm/ddiyyyy B |[ Download Data |[ View Images Local Time: 3:12:05 PM
PROJECT MESSAGES [ View messages | [ Upload images PIPE TALLY DATA [ Zoom In | [Add jointentry | TJIH: 0 TJOH:0 TJP:0 CD:0.00 FT.
DATETIME SENT MESSAGE 4 ATTACHMENT $ USER DATE/TIME IN % iB 4 LENGTH $ DAMAGE CODE
22-03-2021 2:55:15 PM Testing message board No pipe data found

Showing 110 1 of 1 entries Showing 0 to 0 of 0 entries
WEIGHT & BLOCK POSITION Zoom In WEIGHT SOURCE: PADS SWIVEL RPM & TORQUE Zoom In
120 300 7500 150

0 £ a5 5625 1125
3 s 3
& e & 150 gm0 3 75
3 < K &
@ :
30 = 75 1875 375
H
0 o 0 0
PUMP DISCHARGE Zoom In WELL DISCHARGE Zoom In
350 3000 350 15000
Z 2625 2250 z 2625 11250
°© o
g 2 ® o
. 1l = 1
s & 1500 € 475 & 7500
kd E H 3
% H & =
5 s 750 2 15 3750




Project View

» Projects are defined by the user as follows:
» Start and End Date of Project
» Well information can be added

» Equipment to be Used, e.g., a rig, pump(s) and swivel

» Provides Pipe Tally Information - manually input

» Collects all messages from project identified equipment and
displays in the Project View

» Provides data grouping for project for later export in a “flat
file"
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Engine Dashboard

HOME EQUIP DETAIL ENGINE DETAIL ACTIVITY CAMERA FEED

100 Demo Demo

Greenville Demo Demo 3 - 0 mph 2:59:47 PM

ENGINE INFORMATION DRIVE / GEAR GEAR
INFORMATION INFORMATION

DRIVE TRAIN D

DISENGAGED

GEAR ATTAINED

——] R

EQUIPMENT LOCATION - TRAVEL TO SITE

MISCELLANEOUS TODAY'S MESSAGES
BPRINT

Odometer -
Miles

Engine Hours

Hours

Daily Fuel Consumption 0.000
Gallons




Engine Dashboard

» Connects directly to the Engine’s ECM
» Available to all equipment types (Rigs, Pumps and Swivels)

Data available is restricted to the sensors connected to the
Engine’s ECM
» Air Pressure data is collected directly using a transducer

» Message Board system is independent from the Operation’s
dashboards to allow mechanics to send messages that are not

viewed in the operations display.

@ RigsEye




Other RigsEye Features

» Security Based System with various levels of authorizations
available to the Company

Export of raw data
Shift Summary Reports

Project Summary Reports

vV v . v Vv

Control Box provides other Systems - Interlock and Rod
Transfer Safety Systems - see next slides

@ RigsEye




Rod Transfer Safety System

NOTES:

1) Posi-Stop Console or Auxiliary Box sends signal to
Solenoid Valve to close the Normally Open Port
(to the clutch and throttle) and open the
Normally Closed Port (to the Brakes)

2) The Footswitch and/or the Breakaway Pin can
activate the Solenoid Valve as per Note 1.

3) Auxiliary Box Provide the Inputs for Rod Handler,
Interlock and other data collection sensors. For
Interlock and Rod Handler the Aux Box has the
motor controller to activate the Solenoid Valve.

4) RigsEye Box collects the data from the Posi-Stop,
Aux Box and stores internally and transmit via
cellular network to a remote server.

Auxiliary Box RigsEye Box

A ——————
1 Rig Power Supply
To Clutch, ttl
alClutehjhratie Solenoid Valve [
B —— Air Supply
To Brakes

>

Patent Pending
System allows the ri
hand in the basket t
engage the the draw
works brake while
transferring the rod
to avoid the block
moving before the
hand in the rod
basket is ready

SKstem also has a
sheer pin installed
on the air cylinder
that when the ram is
extended to an
unsafe position the
draw works brake
will be engaged to
avoid pullm% the
apparatus of the
mast
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Interlock System

Dog Proximity Switch NOTES:

1) Posi-Stop Console or Auxiliary Box sends signal to
Solenoid Valve to close the Normally Open Port
(to the clutch and throttle) and open the
Normally Closed Port (to the Brakes)

2) Once the Proximity Switch Detects the Dogs are
engaged the Auxiliary Box will start the timer. If
the timer runs out the Auxiliary Box will send the
signal to the solenoid valve to engage the brakes.

3) Auxiliary Box Provide the Inputs for Rod Handler,
Interlock and other data collection sensors. For
Interlock and Rod Handler the Aux Box has the
motor controller to activate the Solenoid Valve.

4) RigsEye Box collects the data from the Posi-Stop,

LED Light Aux Box and stores internally and transmit via

cellular network to a remote server.

3 Way JB

Auxiliary Box RigsEye Box
|
I Rig Power Supply

<
To Clutch ttl

o Lutd /Thro € Solenoid Valve —

< Air Supply

To Brakes




CONTACT INFORMATION

For more information on RigsEye, please contact:
» Alex Nield
> (864) 404-5308

» gan@posi-stop.com

» Visit our Website www.posi-stop.com
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http://www.posi-stop.com

